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Tutorial Data Structure 
In addition to this document, several support files are also distributed. They are organized in different 
folders described in the following sections 

Root Folder 

Contains only this document. 

“GIMS Database” Folder 

The “GIMS Database” folder contains the file gsample.mdb. This is a GIMS databases containing diagrams 
used during the exercises as well as other diagrams for you to browse through. 

In Exercise 1 you will learn how to set it up as the GIMS reference database. If you do so, we advise you not 
to store any other GIMS databases in that folder, which would comprise the reference database setup. 

“GXT Files” Folder 

The “GXT Files” folder contains all GXT files used during the tutorial. 

“SNS-SPS Databases” Folder 

The “SNS-SPS Databases” folder contains SNS-formatted databases used in the tutorial, especially during 
the PFD examination exercises. 

“Videos” Folder 

The “Videos” folder contains videos showing you how to perform most of the exercises’ tasks of this 
tutorial.  

Watch the videos via the menu.html file, which requires you to install the Adobe Flash Player 
(http://get.adobe.com/flashplayer/). 

http://get.adobe.com/flashplayer/
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Dedicated Tracks 
If you do not have time to complete the whole tutorial or if you already know some features of GIMS and 
want to discover other features, here are several sets of exercises that you could find useful. 

Quick Tour 

There are 15 exercises in this tutorial and most of the exercises are divided into several tasks. It could  take 
you a few hours to complete all of them. 

Here is a list of exercises that you could complete in about 1 hour and that would still give you a good idea 
of the GIMS capabilities. 

Exercise 1: GIMS Startup 

Exercise 2: Database Management 

Exercise 3: Database Navigation 

Exercise 5: Discover GIMS Functionalities (Watch the videos…) 

Exercise 6: Create a Simple Diagram 

Then choose an exercise from the following three: 

Exercise 7: Digitize a Diagram (Requires a digitizer) 

Exercise 8: GXT Manipulation  

Exercise 11 : Use PFD Examination Tools – Task1 

Calculations 

Here is a subset of the exercises that introduce the calculation capabilities of GIMS. 

These exercises assume that you have a knowledge of the basic GIMS database browsing features. 

Exercise 10: Use of Gain Interpolation Tools 

Exercise 11 : Use PFD Examination Tools  

Exercise 12: Use PFD Examination Tools in GIBC and GIMS  

Validation 

This track covers the diagram validation features of GIMS and GXTEdit.  

These exercises assume that you have a knowledge of the basic GIMS database browsing and GXT files 
manipulation features. 

Exercise 9: Basic Diagram Validation 

Advanced Exercise 1: Diagram Correction – Data Consistency 

Advanced Exercise 2: Diagram Correction – Software Consistency 

Video Track 

 

Open the file menu.html  

in the Videos folder and enjoy ! 
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Exercise 1: GIMS Startup 

Goal 

Startup GIMS and check whether the reference database is installed correctly. 

Introduction 

GIMS is a software that is mainly used for the capture and display of graphical data relating to 
geostationary satellites. It is also possible to perform interactive PFD calculations. 

This software is available  

 on the SRS DVD that is issued twice a year, in March and October,  

 on the BRIFIC CD-ROMs, which are distributed every fortnight 

 on the GIMS Web page, http://www.itu.int/ITU-R/go/space-software-graphical-interference-
management-system/en 

The installation of GIMS from the SRS DVD or BRIFIC CD is effected by means of the installation programme 
contained in the BR_SOFT folder. Simply launch the setup.exe programme and follow the instructions.  

Setup is obviously the same on all three media but its behavior is somewhat different as regards the 
installation of the reference database REFDB available only on the SRS DVD. Therefore if you install GIMS 
from the Web or an IFIC CD you will not have access to this data. 

It will however be easier to take this workshop if GIMS is properly configured and that a database is 
recognized as REFDB. Task 2 of this exercise will show you how to proceed. 

. 

Task 1: Startup GIMS 

To launch GIMS,  

 click on the Windows "Start" button,  

 then navigate through the list of installed programmes until you reach the "BR Space Applications" 
folder.  

 Select the GIMS folder and, lastly,  

 click on the GIMS icon. 

If you are using GIMS, or a new version of GIMS, for the first time, the online help page is automatically 
displayed.  

Here you have an opportunity to click on the "History of Changes" link to view the latest changes made to 
the software. Otherwise, simply close the window (we will see later how to return to the online help). 

If REFDB has never been installed you can ignore the error messages that may appear at startup. We 
address them in task 2. 

Task 2: Setup REFDB 

If you have not already installed GIMS from a SRS DVD, here's how to configure REFDB as gsample.mdb, the 
database that is distributed with this tutorial. 

 in the Database menu, click REFDB Setup. 

 in the "Master REFDB Location", type the path to the folder that contains the file gsample.mdb 

 Click "Apply" and then "OK" 
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The "Master REFDB Location" is where GIMS searches for REFDB. If this folder contains several databases 
supported by GIMS, the latest will be considered REFDB. In this workshop, we advise you not to save any 
new databases in that folder. 

Task 3: Verify REFDB availability 

All diagrams notified to the Radiocommunication Bureau are loaded into the reference database, REFDB, 
which is distributed on the SRS DVD only. This database can also be regularly updated by means of the data 
distributed on the BRIFIC CD. 

GIMS seeks to make management of the REFDB as simple and transparent as possible. REFDB is copied 
onto your hard disk during the installation of GIMS and, if all has gone well, REFDB will be directly 
accessible from the first time you use GIMS.  

If you see "REFDB" in the GIMS database toolbar at the top of the main window, REFDB has been correctly 
configured. 

The latest changes made to REFDB are distributed on the BRIFIC CD. Thanks to the incremental update 
process, you can update your reference database once a fortnight. Here again, the watchword is simplicity: 
all you need to do is insert the BRIFIC CD and launch GIMS. As REFDB opens up, the programme checks to 
see whether an update is available on the CD and, if so, launches the update automatically. 

The incremental update can also be launched "manually" from GIMS by selecting the 
Database | Incremental Update menu. 

It is important to note that REFDB is a database that you cannot modify yourself. The incremental update 
is the only way in which it can be updated. 
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Exercise 2: Database Management  

Goal 

Locate the database management functionalities and create a new empty database. 

Introduction 

The management functionalities of the databases used by GIMS are grouped within the database toolbar, 
on the left side of which is the list of currently open databases, and also in the "Database" menu. 

By default, when starting up, GIMS will always attempt to open a connection to the reference database 
(REFDB). This behaviour can be changed in the GIMS options, which can be accessed by selecting the 
Edit | Preferences menu and then clicking on the "Database" tab. 

In the Database | REFDB Setup menu, you can change the options relating to the reference database. It is, 
however, recommended that you keep the default options unless you really need to change them (for 
example, in order to share REFDB within a folder on your internal network). 

The Database menu takes you to the management functionalities of the databases used by GIMS. 

Task 1 : Create a New Empty Database 

For example, we can create a new, empty database  
by selecting the Database | New menu. We must then select a folder in which the database will be saved 
(e.g. C:\Br_soft\Workshop\) and give it a name (e.g. work).  

The new database appears in the list of open databases and is now the current database.  

REFDB has taken second place in the list. Later on, we will be able to save diagrams in this new database. 
Remember that REFDB can be modified only through incremental updates. 

Task 2 : Close the Current Database 

To close the connection to the new database, select the Database | Close menu in order to close the 
current database. 

Task 3 : Open an Existing Database 

To open an existing database, select the Database | Open menu. 

For quick opening of the new database, double-click the corresponding line in the list of recently opened 
databases.  

Otherwise, double-click on "More files ..." and locate the database you wish to open.  

Note that the same dialogue box is used for creating and opening a database: simply select the option 
"Create a new empty database" or "Open an existing file". 
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Exercise 3: Database Navigation 

Goal 

Learn how to use the Database Explorer to browse database content, export data to another database and 
open a diagram. 

Introduction 

Once a database is open, its content can be viewed. 

Task 1 : Search a Particular Notice 

 Begin by ensuring that REFDB is the current database.  

 Then, select the Database | Explore menu or click on the corresponding icon on the database 
toolbar.  

You should then have in front of you the database explorer. 

You may search for a particular notice by typing its ID in the text box at the top left-hand corner.  

 

 For example, try entering the value 94520039 and clicking on the button just to the right or 
pressing Enter.  

The corresponding notice is then highlighted. You may also choose an ID previously selected from the list. 

Task 2 : Filter Database Content 

The content of the browser can be filtered according to three criteria: satellite name, administration code 
or notification reason.  

 

 In the list under the words "Filter by", select "Satellite Name"  

 Type "intelsat" in the box on the right 

 Click on the filter button beside the box or press Enter 

The browser will now display all the notices in which the satellite name contains the string of characters 
"intelsat".  

 Now select filtering by administration code 

 Type the code "hol".  

Only satellites notified by the Netherlands will be displayed.  

You will by now have noted that the filter is applied recursively and that the second filter thus applies to 
the result produced by the first one.  

 Finally, we will select only those notices that have notification reason "C". 

To cancel the filter(s) and again have all the notices displayed, simply click on the filter button with a cross 
on it. 
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Task 3 : Export Data 

It is in the database explorer that you can apply operations to all the diagrams of a given notice.  

For example, it is sometimes useful to copy all the diagrams of a given notice into another database.  

To perform this operation,  

 Select a notice  by clicking on the notice ID 90998027 

 Bring up the context menu by clicking the right-hand mouse button.  

 Next, select "Export".  

A dialogue box will appear in which you must select the destination database;  

 select the database that you previously created, 

o if you had skipped that exercise you can still use the same dialog box to create a new empty database now 

 then click on the OK button. 

Note that the other operations are not accessible since they would require a modification of the database 
in which you are currently browsing. Since that database is the REFDB, the software does not authorize you 
to modify it. 

Task 4 : Open a Diagram 

We can now check that the notice has been correctly exported by opening the target database. This can be 
done without closing the explorer 

 by simply clicking on the top right-hand button in the "Database" block. 

 

 By double-clicking on the notice number you will see all of the beams. 

To display a diagram, simply place a tick in the boxes corresponding to the diagrams you wish to see. For 
example,  

 we can open all the diagrams for the EH beam by ticking the box to the left of the EH line.  

 To complete the operation, click on the "Open" button. 
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Exercise 4: GimsQry 

Goal 

Learn how to use the GimsQry software to browse database content. 

Introduction 

GimsQry is a separate software application that creates list of diagrams based on simple search criteria. It 
provides another way of looking into a GIMS database.  

Task 1 : Create a list of diagrams based 

GimsQry can be launched in the conventional way from the Windows Start button, but we are going to 
launch it from within GIMS. 

 In GIMS, ensure that REFDB is the current database 

 Select the Database | Tools  |  GimsQry menu or click on the GimsQry icon  in the database 
toolbar. 

The programme starts up and automatically connects to REFDB. The idea is to fill in the data filtering 
criteria, whereupon a list of diagrams corresponding to those criteria is displayed. We will use the same 
criteria as in Exercise 3. 

 In the "Satellite Name" field, type "intelsat*". Note the use of the * to indicate that "intelsat" is not 
the exact name of the satellite.  

 Click on the button besides the "Administration" field to get the administration codes from the 
database and then select "hol" 

 Select the Notification Reason "C".  

 Then click on OK to display the list of selected diagrams. 

 You can now, for example, print the list or, by double-clicking on one line within it, open the 
corresponding diagram in GIMS.  
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Exercise 5: Discover GIMS Functionalities 

Goal 

Get more familiar with GIMS diagram by learning basic concepts.  

Experience a few handy functionalities. 

Task 1: Select diagram items and view their properties 

 Open  two gain contour diagrams from beams belonging to the same network 

 Left-click on a boresight that is represented by a cross.  

You should see that its appearance changed: it is selected. 

 

 Double-click on a boresight. This brings up a window where you can view and change the boresight 
gain. 

Double-clicking an diagram item is the GIMS way of changing the item properties.  

By default, tooltips are enabled so that one can view properties by positioning the mouse cursor over a 
diagram item. 

 Ensure that the tooltip button is pressed  

 Position the cursor over a gain contour. 

 

Task 2: Copy/paste or drag’n drop 

One can copy diagram items between diagrams using the usual copy/paste mechanism or with the drag’n 
drop feature. 

 Ensure both diagram windows are visible 

 Left-click on the boresight in one window. While keeping the button pressed, move the mouse 
cursor over the other diagram window. 

 Release the button. 
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Task 3: Change map characteristics 

One can customize the map display by changing map characteristics. 

 In the View menu select Display Characteristics 

 Change the projection type to “Plate Carrée” 

 Check the “ITU Regions” box to display the ITU regions borders in the selected color. 

 Click  the OK button. 

Task 4: Copy a diagram to MS Word 

One can copy a diagram image into other documents such as an MS Word document. 

 Open a gain contour diagram 

 In the menu Edit select Copy Picture 

 Check the “Gain Values on Contour” in the Copy Picture dialog box and click OK. 

 Open MS Word. 

 In the menu Edit select Paste. 

Task 5: Use the overlapping mode 

To compare the coverage of two or more beams, you may use the overlapping mode. 

 First ensure that the current database is your personal (work) database.  

 In the Diagram menu, select Open Overlapping.  

 Click on the "Add Layer" button to select the diagrams to be displayed.  

 Select the gain contours of beams EH and WZ from the notice 90998027 

 Click on Open and, as necessary, change the style of the contours in these diagrams ("Set Color" 
and "Set Line Style" buttons).  

 The two diagrams are now displayed on the same map.  

 To modify the displayed diagrams, go into the Layers menu and select Change Diagram Layers. 

 

This type of diagram cannot be saved, but you can print it or copy/paste it into another document. 

All diagrams to be overlapped have to come from the same database  
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Exercise 6: Create a Simple Diagram 

Goal 

Create a gain contour diagram and a service area without using a digitizer. 

Task 1: Create a gain contour 

 In the Diagram menu, select New, then Service Area.  

 Accept the satellite position that is proposed.  

 The capture functions are to be found in the Capture menu. In that menu, select Gain Contour | By 
Elevation.  

 You may modify the gain and elevation values, but in order to create a global contour, simply 
accept the values proposed.  

A contour is created on the horizon. 

 We must add a boresight which we will place at the sub-satellite point. To do this,  

 select the Capture | Boresight menu and accept the default values. 

Task 2: Create a service area 

To create the service area,  

 select the Capture | Service Region | By Country Code or ITU Region menu. 

  In the list of administration codes, select the code for region 1: XR1. 

Task 3: Save the diagram 

You may now save this diagram.  

 If the current database is work, select Diagram | Save.  

This action saves the diagram in the database with which it is associated and whose name is displayed in 
the diagram title bar. 

 If the current database is not work, change things so that it is, and then select Diagram | Save As,  

which saves the diagram in the current database and allows you to change the key elements which identify 
a diagram. 

 GIMS will display a dialogue box showing the elements to be saved. Click on OK.  

 Then, since the diagram is a new one, we have the possibility to capture its identifiers. Capture a 
value for each field, without forgetting the service area number (1, for example).  

 Click on OK to save the two diagrams (gain contours and service area). 

You may now close the new diagram and use the database explorer to check that they have been correctly 
saved. 
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Exercise 7: Digitize a Diagram 

Goal 

Use a digitizer to capture a new diagram. 

Introduction 

We shall now look at how to use a digitizer to capture more complex diagrams. We will assume that the 
diagram is available on paper and that the contours are printed on a map whose projection is recognized by 
GIMS. 

This exercise is using the diagram in Annex 1 that you should print prior to starting task 1. 

Task 1: Recognize the map 

The first thing to do is to create a new diagram.  

 In the Diagram menu, select New, then Service Area. 

 Change the orbital position to –77.5 degrees. 

The second step is to "recognize" the map so that GIMS will subsequently be able to convert the points 
transmitted by the digitizer into points on the Earth defined by their latitudes and longitudes. To do this, 
you must: 

 select the Capture | Recognise Projection menu. 

 With the digitizer mouse, click on six points whose coordinates are known to you (see the six 
numbered points on the map). 

o Use the yellow button or, 

o the left button depending on the mouse you are using. 

 Enter the coordinates of these six points in the table displayed by GIMS. Check that an asterisk is 
present for each line in which you will be entering the coordinates, since this proves that the points 
selected have been correctly digitized. 

 Click on the "Next >>" button. 

 GIMS will now select the most probable projection. Click on OK to accept this choice. 

You are now ready to digitize the contours of this diagram: two gain contours, one service area and a 
boresight. 

Task 2: Capture a gain contour data 

 Before digitizing any gain contours, ensure that the Capture | Gain Information option has been 
selected.  

 You may then digitize the boresight by clicking, with the digitizer mouse, on the boresight 

 You digitize the gain contours by following the contour line while holding down the yellow or left 
digitizer mouse button. 

Task 3: Capture a service area 

 Before digitizing a service area, ensure that the Capture | Service Area Information option has 
been selected.  

 You may then digitize the service area in the same way as you did for a gain contour.  
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Task 4: Filter the digitized contours 

To make fine adjustments to the digitized contours, use the filtering tool to eliminate the irregularities that 
result from the manual digitization process. To do this,  

 select a contour and choose the Tools | Filter menu.  

The filtered contour will appear in blue over the original contour.  

 To accept the filtering and thereby replace the original contour with the filtered contour, select the 
Tools | Accept menu. 

 You may now save this diagram in your local (work) database. 
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Exercise 8: GXT Manipulation 

Goal 

Learn how to use the functionalities related to GXT files: import, export and validation 

In Task 5, you will learn about a new tool to transfer the contents of a series of GXT files into a GIMS 
database. 

Introduction 

A GXT file is a textual representation of a diagram. The GXT format was invented to allow the electronic 
notification of diagram data.  

The GXT format is described in the Attachment 2 of the Circular Letter CR58. 

Task 1: Export a diagram 

To export a diagram,  

 Load the diagram to export from a database using the Diagram | Open menu, or 

 Select the window of a diagram already open or just digitized. 

 Select the Diagram | Export to GXT File menu. Export the diagram into the folder 
C:\BR_soft\Workshop\.  

 Accept the invitation to display the newly-created file, which will enable you to discover the 
GXTEdit software. 

Task 2: Validate a GXT file 

GXTEdit enables you to modify and validate GXT files.  

For example,  

 change the line "[GeoMain]" to "GeoMain" in order to generate a syntax error.  

 Select the File | Validate menu.  

 An error message will appear in the window below the editor window.  

 Click with the right-hand mouse button on the message and select "Details" to view more 
information on the selected error.  

 Restore the original file by using Edit | Undo or File | Reload. 

Task 3: Renumber contour points 

Another interesting function of GXTEdit is that which enables renumbering of the points of a contour. With 
the GXT format, one cannot easily delete a point in the middle of a contour since it is then necessary to 
renumber all the points which follow the deleted point. 

 Delete, for example, point No. 4 of the first contour by  

o selecting the line,  

o clicking on the right-hand mouse button and selecting "Delete Line".  

 In the left-hand part of the main window, where the different sections of the file are displayed, 
right-click on line C1 and select Renumber Points. All the points of the first contour are now 
renumbered. 
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 Now, in order for the diagram to be correct, simply modify the number of points in the contour by 
changing the n_point value. 

Task 4: Import a GXT file 

To view the content of a GXT file in GIMS,  

 While in GXT Edit  

 select the menu File | View with GIMS. 

GIMS is started and the GXT file content is loaded into a new diagram window. 

 While in GIMS, 

o Select the menu Diagram | Import GXT File and select the file to import 

 or drag and drop a GXT file onto the GIMS window. 

o If the file contains more than one diagram, select the diagram(s) you want to import. 

Task 5: Import and Save GXT Files 

GXT files are intended to be used for electronic submission of graphical data. They are text files readable by 
a human user and can be easily created using a software. In addition, usage of GXT files was even more 
compelling with the first GIMS versions that were using a database made up of a set of binary files, which 
would not have simplified the electronic notification of the database itself. 

The main difficulty that occurs rapidly with the use of GXT files is the validation of the data they contain. 
How do we ensure that a file has been properly validated before it is submitted to the BR. In addition, if it 
was properly validated how can the BR be ensure it is really the case? 

The conversion of the graphics database into a Microsoft® Access® container, done a few years ago already, 
can solve these problems. First, each database consists of a single file. On the other hand, saving diagrams 
must necessarily be done via software (GIMS or its associated GIMAPI32 library), ensuring consistency and 
data validation. Finally, all the diagrams corresponding to a network can be grouped into a single file.  

This task will help you discover a new tool introduced in version 7.5, which facilitates the "conversion" of 
GXT files into a GIMS database that you could then submit to the BR. 

 In GIMS, on the Database | Tools menu, click Import GXT Files. 

A new application is started. 

 Click the  icon . 

 Choose the folder "GXT Files \ To Import" provided with this tutorial. 

All GXT files that are in this folder are added to the list of files to import. 

Then select the database in which the diagrams will be saved. 

 Click on the button  

 Select the database "work" created earlier in this tutorial. 

 Click "Start" to start the import. 

 Once the import is complete, an icon indicating the success or failure of the procedure is shown 
to the left of each file. 

 Move the cursor over the icons to see the error message in a tooltip 

 or click on the corresponding line to get the message displayed at the bottom of the window. 
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Note that only files processed successfully or with warning messages are saved. Files that contain errors 
must be corrected before they can be saved 

By default, the program creates a report in which the various messages generated during the import are 
saved. To view this report, 

 Click  at the right of the field "Create report (RTF)"  

To view a GXT file, 

 Double-click the file name in the list of files to import. 
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Exercise 9: Basic Diagram Validation 

Goal 

Validate and correct a diagram 

Introduction 

Diagram validation is not limited to the validation of GXT files. The same validation rules that are applied 
for GXT files are also applied to newly-captured diagrams. 

Diagrams read from a database are considered correct as long as they are not modified,  

enabling them to be transferred from one database to another even if they do not satisfy the new 
validation rules. This is what we are now going to test. 

Task 1 : Validate a diagram 

 From your work database, open the WZ emission beam diagram of notice 90998027. 

 Validate this diagram by clicking on the Diagram | Validate menu.  

GXTEdit is automatically launched and displays the GXT file corresponding to the validated diagram 
together with a series of error messages.  

These messages indicate that several open contours do not have their furthermost points located on the 
horizon. 

 Return to GIMS and change the projection (View | Characteristics) to "Plate Carrée".  

The problem is now clearly visible. 

Task 2: Correct a diagram 

To correct this problem, you could add points using GXTEdit or any other editor, but it will be simpler in this 
case to use the filtering tool, one of whose properties is to ensure that, after filtering, an open contour has 
its two extremities on the horizon.  

 Select an open contour.  

 Select the Tools | Set Filter menu to change the filtering options.  

 In fact, several types of filtering are available. We will select "re-organise points" from the list to 
avoid points being deleted from the contour; all we want is for the contours to be extended to the 
horizon. 

 Click on OK.  

 Now filter the contour by using, for example, the Filter item in the context menu (mouse right-click)  

 The filtered line is displayed in blue on top of the original line. To complete the filter action, you 
have to “accept” the new filtered line so that it replaces the original line. To do so you can again 
use the context menu or more simply press the Enter key. 

The filtering of the first contour modifies the diagram, which triggers its validation.  

All incorrect contours are displayed in bold and dotted form. 

Task 3: Correct all invalid contours 

We leave as an exercise to correct all invalid contours using the filter tool.  
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To correct the error VAL_E003 (“A contour segment is too small”), you can either use GXTEdit to delete one 
of the close points or use the “Remove close points” filter  



23 

Exercise 10: Use of Gain Interpolation Tools 

Goal 

Learn how to use the gain interpolation tools. 

Task 1 : Evaluate the gain at points on the Earth 

You can use the gain calculation tool to obtain an estimate of the antenna gain at any point on the Earth.  

 Open, import or use an opened gain contour diagram 

 Activate this tool by clicking on the corresponding button  in the main toolbar,  

 and then click on the diagram.  

The value of the gain as well as the location of the point are displayed on the right-hand side of the status 
bar at the bottom of the window. 

If you wish to find out the gain at a specific point,  

 Select the Tools | Interpolate menu. 

 Enter the longitude and latitude of the point 

 Click Calculate 

Task 2: Create an elliptical beam 

Let us see now how one can create an elliptical beam that we will then use in the next task. 

 Create a new gain contour diagram 

 Accept the default satellite position 

 Select the Capture | –3dB Ellipse menu.  

 Capture an ellipse  

o that is centered on the position (5E, 45N)  

o with a major axis of 3 degrees and  

o a minor axis of 1 degree.  

o Click on OK 

Task 3 : Generate a contour of a given gain 

Using the gain interpolation algorithm, GIMS can generate contours with a user-specified gain value. This 
function is particularly useful in the case of elliptical beams, since a precise calculation is then effected 
using the antenna pattern. In the case of shaped beams, the result is highly dependent on the complexity of 
the pattern. 

 Open, import or used an opened elliptical beam diagram (the one created in Task 2 for instance) 

 Select the Tools | Create Contour menu and,  

 without changing the gain values proposed, click on OK. 
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Exercise 11 : Use PFD Examination Tools 

Goal 

Learn how to perform an interactive PFD examination 

Introduction 

GIMS features an interactive PFD tool that allows to view graphically the impact of a particular emission. 
The PFD produced by an emission is calculated and compared with a selected Article 21,Appendix 30 or 30B 
provision to generate an excess area. One can then produce the list of countries where an excess occurs. 

The interactive PFD tool well complements the GIBC batch PFD program that analyzes all the emissions of a 
notice and tracks PFD excess for all applicable provisions. 

Task 1: Perform an Article 21 examination 

 From your work database, open the WZ emission beam diagram of notice 90998027  

o or use the already-open version of that diagram in which we corrected the contours.  

 In the View menu, select PFD Examination.  

This opens the PFD View, a new window containing the same diagram but with a different menu.  

 In the Calculation menu, select Article 21.  

This examination enables you to compare the PFD produced by a beam with the limits defined in Article 21 
and the footnotes to Article 5 of the Radio Regulations. 

 Enter the following values: 

o Lower Limit: 10950 

o Upper Limit: 11700 

o Class of station: EC 

o Bandwidth: 27 

o Power density: –50 

o Total Power: 19 

o On-axis gain: 40 

You will see that the only one provision is applicable for the selected frequency band and class of station: 
"RR 21.16" that is intended to protect terrestrial services from interference caused by the fixed-satellite 
service. 

 Now click on OK. 

A red contour is displayed, representing the area within which there is excess PFD. To prove this for 
yourself,  

 activate the PFD tool in the main toolbar ( )and  

 click inside and outside the area.  

The PFD values and the PFD limit defined by the selected provision are displayed in the status bar. 

To see the list of countries experiencing excess PFD,  

 select List of affected countries in the Tools menu. 
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A country is considered as affected if there is a PFD excess on its territory and if that country is in 
the protected area defined by the provision. 

Task 2: Perform an Appendix 30B Calculation  

In Task 1, we first opened a diagram window before opening a second window that allowed us to perform a 
PFD calculation. In this task we will see that it is possible to directly open a PFD calculation window. 

 In the Diagram menu, click Open PFD Examination. 

 In the database explorer, make sure you are viewing data from REFDB 

 Open the gain contour diagram of the beam SUI00_04 of the notice 90558192. 

The window icon of the window that pops up as well as the Calculation menu tells you that this is a window 
for calculating PFD. 

 In the context menu of the window, click Appendix 30B (Annex 3). 

A simple dialog box appears in which only 3 parameters are required. 

An interesting feature was also added in this dialog box that allows you to retrieve the data necessary to 
the PFD calculation from a SNS-formatted database. 

 To use that feature, click on the top right button of the dialog   

If this is the first time you use this feature, the “GIMS Options" dialogue should appear to allow you to 
configure the paths to external databases where GIMS can find the data necessary to calculate the PFD.  

In fact, the GIMS databases contain only diagrams data. All other alphanumeric data such as the gain or the 
power are stored in SNS formatted databases. 

 In the "SPS Database Path" enter the path of an SPS/AP30B database. You can use the database 
sps_ap30b.mdb provided with this tutorial. 

Generally this field is intended for a database containing planned bands data (Appendices 30 and 30B). 
While the field “SNS Database Path" is meant for a database containing unplanned bands data (typically the 
file srs_all.mdb distributed on the SRS DVD). 

 Uncheck the option "Always show Before ..." to prevent this dialog box from appearing whenever 
GIMS needs to access these databases. Indeed it would appear anyway if GIMS could not find the 
data related to the analyzed beam. 

 Click OK. 

The fields in the dialog box are automatically filled. 

For more complex beams it is possible that a dialog box appear through which you can select the 
characteristics of a particular emission. 

 Click OK to start the PFD calculation. 

In this case no PFD excess is detected. Otherwise, as in Task 1, a contour would be created that would 
delimit the region where the PFD limit is exceeded. 
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Exercise 12: Use PFD Examination Tools in GIBC and GIMS 

Goal 

Learn to use the software GIBC and interpret the results it produces for reuse in GIMS interactive 
calculation tools. 

Introduction 

This exercise will help you discover how to use the software GIBC (Graphical Interface for Batch Calculation) 
and GIMS to assess the impact of a new network on existing networks based on the PFD limits defined in 
Appendix 30. 

We will first use GIBC to assess the interference produced by a new network in the BSS planned bands onto 
a non-planned FSS network. 

Then we will see how to use the results produced by GIBC to perform the same PFD calculation with the 
tools provided by GIMS. 

Task 1: Perform a PFD Examination with GIBC 

GIBC is only available on the SRS DVD. Nevertheless important updates are distributed via the IFIC CD. We 
will assume that you could get it and you have it properly installed. 

To start GIBC, 

 you can use SAM (Space Application Manager) 

or 

 click on the Windows "Start" button,  

 then navigate through the list of installed programs until you reach the "BR Space Applications" 
folder. In the GIBC subfolder click on the GIBC shortcut. 

The GIBC interface is organized into tabs. Each tab allows to manage a different technical examination. As 
in GIMS, GIBC can perform PFD calculations under Article 21 (“PFD (terrestrial serv.)" tab), under 
Appendix 30 (“PFD (Space serv.)” tab) and under Appendix 30B ("Appendix 30B” tab). 

 Click the "PFD (Space serv.)" tab 

Several options are available for this calculation. We will just tell the network to be analyzed. 

 In the "Network" field type the ID of the network that we will analyze, namely 110552999 

The next step is to specify the database containing the network data to analyze. The goal of the PFD 
examination that we will perform is to seek the coordination needs between networks in the planned and 
unplanned bands. Data for these two types of networks are stored in different databases often referenced 
by the acronym SPS and SRS, respectively. 

 Click on the "Tools / Options" tab 

 In the "SRS Database, you must select the path of the database containing the network under 
analysis (specified above). It is a network in the planned bands . Use the database sps.mdb 
provided with this tutorial. 

 Click the “Add” button (at the right of the “Additional SRS DB Path”) to add the path of the 
database containing the unplanned bands data. Use the database srs.mdb provided with this 
tutorial. 

GIBC also needs graphical data found in the GIMS reference database. You're supposed to have it 
configured correctly with GIMS for GIBC to connect to it automatically. 
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As part of this exercise, which involves networks with fictitious IDs we have stored their data stored in the  
database gsample.mdb supplied with this tutorial. If you have configured this database as REFDB in 
Exercise 1 you can immediately start the calculation.  

On the other hand, if you already installed REFDB using the SRS DVD you must now provide GIBC with the 
path of the database gsample.mdb. To do this: 

 Under the "Additional GIMS Databases" section click on "Add ..." 

 Select the file gsample.mdb 

During the calculations GIBC will search diagrams it needs in gsample.mdb and if he does not find them 
there will continue his search in REFDB. 

To start the calculation: 

 reactivate the tab “PFD (Space serv.)" 

 click "Start" 

 when the message " Press any key to continue . . . " appears in the DOS window, close it (if you also 
see the message “PROGRAM SNSBPXT TERMINATED OK” 

 note the directory listed under the "Files Path" section in "PFD (Space serv.) tab" and open that 
folder with the file explorer of Windows. 

 in this folder, open the file PXT.LST containing the calculation results. 

Task 2 : Making Sense of PXT.LST 

In Task 1 the PFD examination made with GIBC generated a series of files the most important of which is 
PXT.LST. The lower part of the file that is located after the text "SUMMARY FOR TRANSACTION" lists for 
each applicable provision and for each group the administrations with which it will be necessary to 
coordinate. 

In the upper part of the file PFD excess cases are presented. These examples are by no means exhaustive 
but helps you get an idea of the PFD values produced. From that section we will extract information needed 
to replicate these results with GIMS. 

Here's what this section should look like in your PXT.LST.  

           EXI DOWN-LINK IS AFFECTED 

 

I S PNG   PACIFISAT BSS-159E  159.00E  0.10 0.10  12.24534 G  33000 K  20.07.10 B110.552999/000.018800/0001 

  PNG2R    EB L                      39.8 DB 

       33M0G7W--   16.2 DBW  -59.0 DBW/HZ  -59.0 DBW/HZ                    2D:20.07.10 

 

E S AUS   AUSSAT B 160E MXL   160.00E  0.05 0.05  12.26150 G  2000 K  18.05.95 A C092.520999/092.634426/0001 

  NB       EC                        33.3 DB 

       5K00G1W--  -26.2 DBW  -62.2 DBW/HZ                                  2D:26.03.92 

 E E AUS     TYPE 6.8M                                             56.8 DB 

 

   AP30 AN1 SECT 6       BROADCASTING-SATELLITE 

   REGION 3                         145E04 14S57 AUS                 38.18 -136.96   28.29 -165.25 A30#A1S6.1 

 

We're going line by line to extract information of interest. See Annex 3: GIBC - PFD Analysis Output Files, for a 
description of the GIBC output files. 

I S PNG   PACIFISAT BSS-159E  159.00E  0.10 0.10  12.24534 G  33000 K  20.07.10 B110.552999/000.018800/0001 

From left to right, the highlighted values are: 
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I  indicates this is the information for the incoming satellite (the one we analyzed), 
0.10  longitudinal tolerance West of the nominal longitude of the space station 
12.24534 G the central frequency of the emission 
33000K  the bandwidth of the emission 

  PNG2R    EB L                      39.8 DB 

PNG2R  is the beam name 
39.8 DB is the maximum antenna gain 

       33M0G7W--   16.2 DBW  -59.0 DBW/HZ  -59.0 DBW/HZ                    2D:20.07.10 

16.2   is the maximum peak envelope power 
-59.0   is the maximum power density 

E S AUS   AUSSAT B 160E MXL   160.00E  0.05 0.05  12.26150 G  2000 K  18.05.95 A C092.520999/092.634426/0001 

E  indicates this is the information for an existing satellite (already in the database) 
0.05  longitudinal tolerance West of the nominal longitude of the space station 

   AP30 AN1 SECT 6       BROADCASTING-SATELLITE 

This line indicates the nickname of the provision and to which service it applies. 

   REGION 3                         145E04 14S57 AUS                 38.18 -136.96   28.29 -165.25 A30#A1S6.1 

REGION 3 is the area where the provision is applicable 
145E04 14S57 is the position of a point where the maximum PFD excess (for that pair of emissions) was 
  detected (it is not necessarily the maximum PFD excess detected in the whole analysis) 
AUS  is where the point is located 
38.18  is the antenna gain at that point 
-136.96  is the PFD at that point 
28.29  is the PFD excess at that point 
-165.25  is the PFD limit at that point 

 

Task 3: Making an Appendix 30 PFD Examination with GIMS 

In Task 2, we extracted from the report created by GIBC information we will now use in GIMS to redo a PFD 
calculation. 

The first thing to do is open the diagram corresponding to the analyzed beam as mentioned in the file 
PXT.LST 

 Ensure REFDB is set as the current database 

 Open the co-polar gain contour diagram and the associated service area of the beam PNG2R in the 
network 110552999 

 In the View menu, click PFD Examination 

 In the Calculation menu, click on Appendix 30. 

Under the "Examined Network section, you must specify into which ITU region the beam is emitting and in 
which service it operates. 

The service is clearly BSS.  

For the ITU region, we would be tempted to select Region 3 in view of the notifying administration PNG 
(Papua New Guinea). If you tried this area you would discover that none of the provisions proposed by 
GIMS  match the provision mentioned in the file PXT.LST. 

In fact, to determine with certainty the ITU region where the beam emits it is necessary to look at the 
service area. In our case, it is defined by Region 1. 

To fill in the section "Examination Frequency Limits, use the values of the center frequency and bandwidth 
of the emission. 



29 

 Now, make sure that the first two sections correspond to the image below. 

 

 In the list of provisions, select "AP30 AN1 SECT 6 (I)"1 

To fill the field "Separation angle", we need to calculate the orbital separation of the two networks that is 
an input to the formula defining the PFD limit. We simply use the nominal longitude of the two networks 
and we also take into account the longitudinal tolerance of the two networks. In our case, this is 0.1 and 
0.05 whose sum is subtracted from the nominal separation to get a worst case PFD limit. 

 In the "Separation angle" field , enter 0.85. 

 Then make sure the "Emission" section looks like the following image. 

 

 Finally, click "Start" to start the calculation. 

A message tells you that the PFD limit is exceeded over the entire visible area. Now let’s check the 
calculated PFD value at the point mentioned in the file PXT.LST. 

 In the "Calculation" menu, click "PFD at point" 

 Enter the longitude 145.07 

 Enter the latitude -14.95 

 Click "Calculate" and compare the values with those extracted from the file PXT.LST in task 2. 

To visualize this point on the map, you can use the capture tool that allows to create a service area by 
discrete points. 

 Select the diagram window (not the one that allows for the PFD calculation) 

 In the "Capture" menu, click on "Discrete service points". 

 Enter the point coordinates as above 

 Click OK. 

 Re-enable the calculation window and note that the point just captured also appears in that 
window 

 Activate the PFD tool in the toolbar  or by selecting the menu Tools | PFD Tool 

 Click on the point just created and check the value of PFD in the status bar. 

                                                           

1 "AP30 AN1 SECT 6 (II)" corresponds to the PFD limit set by the Note 1 of Section 6 of Annex 1 to Appendix 
30. 
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Note that if you click a point nearer the boresight you obtain a greater PFD value and therefore a greater 
excess than the one shown in the file PXT.LST. 

In fact, this provision applies only in the service area of the existing network’s beam (which must of course 
be itself included in the zone protected by that provision, namely ITU Region 3). 

 Open the diagram of the service area of the beam NB in the network 92520999 

The service area is defined by the Australian territory where the point is actually located. 

 Click on other points in Australia to confirm that the file PXT.LST gives a value close to the 
maximum value of excess in the service area. 
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Task 4: Solve the PFD Excess 

To convince yourself of the use of the service area in identifying coordination needs, you can change the 
values of power and gain with SpaceCap. You will find that GIBC does not detect any PFD excess anymore 
and you will see through GIMS that there is an excess, but is limited outside Australia. 

Use SpaceCap to: 

 Modify the gain of the beams PNG2R PNG1R. Enter the value 18.5. 

 Modify the power of the emission of the group 18800. Enter the value 9. 

 Run GIBC and use these new values in the GIMS Appendix 30 PFD calculation dialog box. 

Alternatively, simply run GIBC with the database sps_pfd_solved.mdb that has these values already 
modified. 
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Advanced Exercise 1: Diagram Correction – Data Consistency 

Goal 

Get acquainted with the various GXT validation errors and the use of the filter tool to correct them 

Task 1: Correct crossing contours 

Gain contours may not cross each other. GIMS ensures that this does not happen when you use the 
digitizer. However this could happen in a GXT file that was generated from other sources. 

Usually there is no simple way of correcting this problem. One can use GXTEdit to manually change points 
coordinates. Some crossings can also be corrected with the GIMS filter tool, which is what we are going to 
experience in this task. 

 Startup GIMS and import the file crossing.gxt 

 Select the -2dB contour 

 Right-click on the diagram window and select Set Filter 

 Set the filter option values as below: 

 

 Click OK 

 Right-click on the diagram window and select Filter 

 Compare the blue, filtered, contour with the original one. 

 Right-click on the diagram window and select Accept 

 Apply the filter a few times until the diagram is correct. 

 In the menu Diagram select Validate, to ensure that the diagram is correct. GXTEdit is launched 
and does not show any errors. 

Task 2: Correct loops 

Neither gain contours nor service areas can loop, i.e. they cannot cross themselves. This often occurs at the 
contour’s ends. If this is the case, you can use GXTEdit to change the points coordinates. Filtering can 
sometimes help as we will see in this task. 

 Startup GIMS and import both the gain contour and the service area diagram from the file loop.gxt.  

 Double-click on the map to view  the display characteristics and change the satellite projection to 
Plate Carrée. 

 The service area point indicates where there is a loop in the gain contour. Zoom in that area. 
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 Select the contour to filter 

 Right-click on the diagram window and select Set Filter 

 Set the filter option values as below: 

 

 Click OK 

 Right-click on the diagram window and select Filter 

 Right-click on the diagram window and select Accept 

 Apply the filter a few times until the diagram is correct. 

 In the menu Diagram select Validate, to ensure that the diagram is correct. GXTEdit is launched 
and does not show any errors. 

Task 3: Correct open contours 

An open contour is a contour whose end points are not matching. This is valid as long as the end points are 
clipped to the visible earth horizon.  

Let us see how one can easily fix open contours with end points that are not on the horizon. 

 Startup GIMS and import the file “open contours.gxt” 

 Double-click on the map to view  the display characteristics and change the satellite projection to 
Plate Carrée. Invalid open contours are now clearly visible. 

 Select a contour to filter 

 Right-click on the diagram window and select Set Filter 
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 Set the filter option values as below: 

 
All filter types do contour extension. The filter “Re-organise points” also ensures that the contour’s 
shape is not dramatically modified. 

 Filter the selected contour by pressing Ctrl + F 

 Press the Enter key to accept the filtered contour2 

 Filter all invalid contours. 

 In the menu Diagram select Validate, to ensure that the diagram is correct. GXTEdit is launched 
and does not show any errors. 

 

                                                           

2 The “Delete” key cancels the filter. 
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Advanced Exercise 2: Diagram Correction – Software Consistency 

Goal 

Learn what are the limitations imposed to diagram data by software considerations and learn how these 
can be fixed with the filter tool. 

Introduction 

Gain contours and service area contours are made up of points joined by line segments. The total number 
of points is limited to about 4000. The value is not fixed. The GIMS low-level components use a fixed size 
buffer to store a diagram. The number of points available for contours may vary depending on the number 
of boresights and the number of contours. 

The validation issues an error when you exceed the limit because the software could have an unpredictable 
behavior. 

The number of points and the number of boresight are both limited to 99. 

As we will see in the exercises, the filter tool can help you reduce the number of points in contours. 

The distance between points in a contour cannot be smaller than 1km. Task 2 shows how to use the filter 
tool to fix this problem. 

The distance between points may not be too large either. Otherwise the gain interpolation may give 
strange results. Task 3 show how the filter tool can be used to ensure that the distance between points is 
good enough to ensure that the gain interpolation works correctly. 

Task 1: Reduce the number of points in a diagram 

 Startup GIMS and import the file “too many points.gxt” 

 Move the mouse cursor to view tooltips 

 Find out contours with high reduction factors3 (>3).  

 Select the contour 

 Right-click the diagram window and select Set Filter 

 Select the Full Filter type and check the Proposed reduction factor option 

 Click OK 

 Press Ctrl+F to filter the contour.  

 Press Enter to accept the filtered line 

 Use the tooltip again to check that reduction factor should now be close to 1. 

 Filter other contours until the diagram is valid. On less important contour, set manually the 
reduction factor to a high value. 

Task 2: Remove too close points 

 Startup GIMS and import the file “close points.gxt” 

 Three contours appear to be invalid (GIMS displays them with a thick dotted line style) 

We are now going to use GXTEdit to correct one of them. 

                                                           

3 The reduction factor is the value by which the filtering will divide the number of points in a contour. The 
proposed value is calculated by GIMS to reach a reasonable number points in the selected contour. 
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 Run the validation by selecting Validate in the File menu 

 Double click on the first error message 

The last two points of the contour are identical. We are going to remove one of them 

 Right-click on the selected line and select Delete Line 

 Double-click on C1 in the left window (showing the file’s sections) to view the beginning of the 
contour’s section 

 Double-click on the n_point line and change the value to 116 

 Right-click on the C1 line in the left window and choose Renumber points. 

 Choose File | Save As and save the modified file. 

 Choose File | View with GIMS to import the file into GIMS 

Only two invalid contours are left. Let us use the filter tool to correct them. 

 Select one of the invalid contour 

 Right-click the diagram window and select Set Filter 

 In the filter list, select Remove close points and click OK 

 Press Ctrl+F to filter the contour.  

 Press Enter to accept the filtered line 

 Select the other contour. Press Ctrl+F and Enter. 

The diagram is now valid. 

Task 3: Ensure that the distance between point is large enough 

Contour points are joined by line segments. On the earth, this is valid as long as the distance between 
points is not too big. Most of the time the gain interpolation may perform correctly. However the gain 
interpolation may be problematic with diagrams having contours very close to each other and also close to 
the horizon.  

In this case it is necessary to add points to contours as we will see now. 

 Start up GIMS and import the gain contour and the service area from the file “crossing azel 01.gxt”  

 Switch the map projection to Plate Carrée 

 Use the gain tool  to check the gain at the service area point 

The gain  is -4dB. The gain of the contour on the left of the point is -2dB. The gain of the contour on the 
right is -3dB. In principle the gain at the service point should be between these two values. It is now -4dB. 
You can also see that three contours (thick and dotted) are considered as invalid. 

 Switch the map projection to Satellite View and zoom on the area of the service point.  

You can see that the position of the service point vs. the gain contours is not obvious. The gain contours do 
not have enough points and therefore are not following longitude lines as they are intended to. Actually  

Let us use the filter tool to add points to the invalid contours. 

 Switch back to the Plate Carrée projection 

 Select the -0dB contour. 

 Right-click the diagram window and select Set Filter 

 In the filter list, select Add points and click OK 

 Press Ctrl+F and Enter to filter the contour. 
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 Filter the -2,-3 and -4 dB contours (in that order) 

 Use the gain tool  to check the gain at the service area point 

The gain is now between -2 and -3 as it should be. 
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Advanced Exercise 3: Use Microsoft Access® to Read a GIMS Database 

Goal 

Learn how to open a GIMS database with Microsoft Access® 

Introduction 

The GIMS data are stored in an Access® database. However GIMS databases are secured in such a way that 
modifications are possible only through GIMS and the GIMAPI32 library. 

Still it is possible to use Access® to open GIMS databases in read-only mode, which you may find useful to 
build your own queries. 

Task 1: Startup Microsoft Access® to read a GIMS database 

 .Right-click on the Windows® desktop and select New | Shortcut 

 Click the Browse button and look for the file msaccess.exe (maybe in C:\Program Files\Microsoft 
Office\...) 

 At the end of the msaccess.exe path add: /wrkgrp c:\br_soft\system32\gims.mdw 

 Click on Next >. 

 Change the name to MSACCESS for GIMS. 

 Click on Finish. 

 Double-click on this new shortcut to start MS Access® 

 On the File menu, select Open and browse for the local database create earlier: 
C:\Br_soft\Workshop\work.mdb 

 Use guest for the username and password. 

You can now create and save queries that do not modify the data. 
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Annex 1: A Gain Contour and a Service Area to Digitize 
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Annex 2: An AG/GSO Diagram to Digitize 
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Annex 3: GIBC - PFD Analysis Output Files 
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